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Chapter 4 Building Web Pages

This chapter provides detailed step-by-step instructions 
for Web page building, demonstrating the capabilities of 
GoLive CyberStudio’s page building environment. 

General You can use the following tools for page building (see the screenshot 
on page 52 for reference):

• The Palette window contains five different tabs, four of which 
are useful for page building. Three tabs hold selections of HTML 
tags, while the fourth tab contains Frames and Frame Sets.

• The context-specific Inspector 
and create links, depending on the current selection. 

• The Color Picker offers a variety of different color spaces to make 
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Each document view has a dedicated tab, which can be selected by 
clicking at the desired tab rider, where its name appears.

The following screenshot illustrates the GoLive CyberStudio page 
building environment (Layout view shown) and explains the major 
features.

The Page Building Environment

The Toolbar helps you format text and launch 
your favorite browser(s).
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Creating Stationery To create a custom stationery page, proceed as follows:

1 Create a template page in GoLive CyberStudio, adding all the 
standard page elements you want to reuse—for example, layout 
grids, images, headers, etc.

2
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Selecting a Language WorldScript and Text Encoding Converter, Apple’s proprietary lan-
guage support technologies, make GoLive CyberStudio the premier 
Web publishing package for multi-lingual Web sites.

The TECEncoder module, a special modular software component 
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To turn individual encodings on and off in the Document Encoding 
submenu, proceed as follows:

1 Choose the Preferences command from the File menu or press 
Command-Y, then open the Encodings group of preferences as 
set out above.

2 In the Encodings dialog box, locate the desired encoding option 
and click into the checkmark column to enable or disable the 
item of your choice. Encodings are disabled if unchecked and en-
abled if checked, respectively.

3 To use a newly enabled encoding scheme, simply choose it from the 
submenu of the Document Encoding command in the File menu.

To determine whether encoding and character set information 
should be included in the HTML page header, proceed as follows:

1 Select the Use Charset Info checkbox at the bottom of the dialog 
box to have GoLive CyberStudio include the encoding and char-
acter set information in the CONTENT attribute of the META tag. 
Deselect this checkbox to eliminate the language information 
from the HTML page header. 

2 In the Character Scan Limit, type in an appropriate number of 
bytes that you want GoLive CyberStudio to search for encoding 
and character set information when it opens a file. This text box 
blank is automatically disabled by deselecting the Use Charset 
Info checkbox.

Note: The same can be achieved using the Encodings checkbox 
on the HTML tab of the 
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Making Basic Page 
Settings

You can now proceed to make basic settings for your page layout. 
GoLive CyberStudio supports the following options:

• default window size
• page title
• background image
• background color
• text color
• basic HTML elements

Selecting a Default Window Size

To select a default window size that the Web browsers of your audi-
ence use when opening your page, proceed asthe fols:

1 Locate and pop up the Window Size 
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Giving Your Page a Title

To name your page, proceed as follows:ttings1Click the default title Welcome to GoLive CyberStudio. Clicking se-
lects the title for overwriting. 2Type in the page title of your choice and press the Return key.

Naming a PageSelecting a Background Image

To select a background image, proceed as follows:ttings1Open the Inspector window if it is closed by choosing Inspector 
from the Window menu or pressing Command-1.2Click the small page icon in the upper left corner of the docu-

ment window. This opens the Page Inspector in the Inspector win-
dow.3 In the Page Inspector, click the checkbox labeled Image
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The HTML Tab of the Page Inspector

To create HTML fragments, proceed as follows:

1 Create a new document by selecting the New command from the 
File
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Saving Your Page Go to the File
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Setting HTML 
Preferences

HTML-related options are contained in the Preferences - General - 
HTML dialog. 

The Preferences - General - HTML Dialog 

The Preferences - General - HTML dialog box contains the following 
options:

• Select the Return in lists creates big offset checkbox to have 
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Editing Tools Once you are finished with the basic settings, you can start adding 
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The Inspector

Accompanying each element dropped in your page is a context-sen-
sitive Inspector window that allows you to directly view, edit, and 
modify the attributes of objects on your page, such as images, Java 
applets, and links. The Inspector relieves you of the burden of click-
ing OK repeatedly in multi-level dialog c
xes, thus helping you to 
maximize your production workflow. 

The Inspector Window

The Project Tags tab features a selection of generic site ele-
ments for project management. For more information, see 
Chapter 15, Managing Web Sites with GoLive CyberStudio, on 
page 395.

The WebObjects tab contains a group of ready-to-use WebOb-
jects tags that let you build dynamic pages. Please refer to 
the instructions starting on page 231 for more details.

The Favorites tab lets you store frequently used objects for 
insertion into your page. Please refer to the instructions 
starting on page 72 for more details.
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Inserting the Image icon from the Palette onto the document opens  the Image Inspector (right).
Inserting and Editing When you insert a tag or object, the proper set of options pops up in the 
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Resizing Options Interactive Resizing

You can resize an object by dragging with the mouse and have 
GoLive CyberStudio update the display in real time. 

If the object is within an HTML text flow, GoLive CyberStudio auto-
matically maintains inter-object spacing while you resize. 

To use interactive resizing with any object, proceed as follows:

1 Control-click any object handle to resize, or Control-Shift-click 
the handle to resize proportionally.

2 GoLive CyberStudio updates the display of the object’s content 
while you resize. In an HTML text environment, surrounding ob-
jects and text are pushed away while you drag, maintaining in-
ter-object spacing.

3 You can return to non-visual resizing by releasing the Control key 
while you are dragging.

You can also return to non-proportional resizing by releasing the 
Shift key while you are dragging.
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Size layout grids with your audience in mind. As a rule of 
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Once you are finished resizing, you can set up the grid using the Lay-
out Inspector. The Layout Inspector appears in the Inspector window 
whenever you drop a layout grid in your document or click to select 
one.

The Layout Grid Inspector

To set up the grid, proceed as follows:

1 In the Horizontal text box, enter the spacing between the hori-
zontal lines of the grid—for example, 16 pixels.

2 Check the Visible checkbox to have GoLive CyberStudio display 
the grid, or uncheck the checkbox to hide the grid.

3 Check the Snap checkbox to make the grid magnetic, that is, po-
sition objects only at the grid points. Uncheck the checkbox to 
position objects anywhere on the grid.

4 Repeat Steps 1 through 3 in the Vertical section of the Layout In-
spector.

5 Select an alignment option from the Align popup menu. This op-
tion controls the position of the layout grid with respect to the 
document window:

- Default uses the settings of the surrounding HTML container 
to
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zes to 

• The Relative Size submenu lets you choose custom font sizes to 

override the default font size of the browser. choose custom font si
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 menu and choose  (see above).
Using Font Sets

To ensure compatibility with Microsoft’s Internet Explorer, GoLive 
CyberStudio allows you to store font sets with each page. Based on 
the FACE attribute of the FONT tag, a font set adds a list consisting of 
one or more font names to the currently selected text. If the first font 
on the list is available on the end user’s system, it will be used to dis-
play the text formatted accordingly. If not, the second font is used, 
and so on. If none of the fonts on the list is available, the text will 
appear in the default font of the Web browser.

Choosing the Edit Font Sets Command 
from the Style Menu

To create a font set, proceed as follows:

1 Select the desired text. 

ttot to the Styled on The Edit Font Sets Dialog Box
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22 r ex-

 y.322 u reuse 
4 Choose the desired fonts from the Font menu (on the right side 
of the dialog box) and click the Add button to add them to the 
current set. (The fonts appearing on the Font menu are your cur-
rent system fonts.)

5 When you have added all desired fonts, click OK to close the dia-
log box and apply the font set format. 

Font sets are always named after the firsed .322 m36en the list— .3
ample, Times.

Once y.322 u ha.322ve created ad .322 m36set, GoLive CyberStudio lets
it withen the same document. 

To choose an existing  .322 m36set, proceed as  .322 llows:

1 Select the desired text.
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The Format Menu
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Alignment
Aligning Paragraphs Using the Format Menu 

The Alignment submenu to the Format menu lets you align text or 
objects.

Alignment Submenu of Format Menu

To align the current paragraph, selected text, or object, choose the 
Left, 
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Numbered and Unnumbered Lists

In addition to the basic list formatting options offered by the Toolbar 
(see page 91), you can create custom numbered and unnumbered 
lists by selecting the appropriate list style from the List submenu. 

The following example shows a numbered list formatted with the 
Upper Roman option.

Numbered List

To apply a custom list style to the current paragraph or selection, 
choose the appropriate option from the List submenu.

Hierarchical Lists 

You can also create hierarchical or nested lists with multiple num-
bering schemes or different leading characters.

The following example shows an unnumbered hierarchical list.

Hierarchical List

To nest individual list items that you want lower in rank, proceed as 
follows:

1 Select the list item. 

2 Go to the List submenu and choose a different style. 

3 Go to the Format, choose List. Then choose Increase List Level.





92 CHAPTER 4 Tables
help you present information in spreadsheet form. 

 onto 
your page or double-click the table icon in the Palette .

After inserting a new table, you can change its appearance, resize the 
entire table or individual rows and columns, add color, and select 
the alignment of objects within cells.

The following screenshot shows a table designed with GoLive 
CyberStudio. This example has a leading caption, three columns, and 
five rows.
To insert a table, drag & drop the table icon from the Palette
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Inserting a Table To insert a table, proceed as follows:

1 Drag the Table icon from the Palette.

2 Drop it on your layout grid and position it as desired, or drop it 
on your document window if you’re not using a layout grid.

Inserting a Table

Resizing a Table After inserting a new table, you can resize individual cells, rows, col-
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You can select a measurement option from the popup menu 
next to the Width text box:

- The 
- The 
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You can select a measurement option from the popup menu 
next to the Height text box: 

- The Auto option sets the height automatically by dividing the 
overall height of the table through the number of rows.

- The Pixel option lets you enter the height precisely in pixels.

- The Percent option lets you enter the height relative to the 
overall height of the table.

The Cell Tab

The Cell tab of the Table Inspector lets you edit the attributes of the 
current cell, allowing you to control the alignment of text in cells, as-
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7 Instead of dragging to resize, click to place the cursor in the 
Width text box, enter the desired column width, and press the Re-
turn key to confirm your entry.

You can select a measurement option from the popup menu 
next to the Width text box:

- The Pixel option lets you enter the width precisely in pixels.

The es5 Tf
1.81 0u can selTxt to t5 0 38 the[Pixel
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Adding and 
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Setting Up an Image After linking the image placeholder with an image file and placing it 
at the desired location, you can proceed to adjust the image’s at-
tributes.

You can set up an image using the options on the Basic and Special 
tabs of the Image Inspector. (The Map
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Adjusting Image Alignment

To adjust the alignment of an image that was not placed on a layout 
grid, proceed as follows:

To align the image relative to text on the same line, select an op-
tion from the Alignment popup menu:

- The Top option aligns surrounding text with the top of the im-
age.

- The Middle option aligns the baseline of surrounding text with 
the center of the image.

- The Bottom option is the default setting. It aligns the baseline 
of surrounding text with the bottom of the image.

- The Left option aligns the image to the left of the text.

- The Right option aligns the image to the right of the text.

- The Texttop option aligns the image with the top of the sur-
rounding text.

- The Absmiddle option aligns the absolute center of surround-
ing text with the image.

- The Baseline option aligns the image with the baseline of the 
surrounding text.

- The Absbottom option aligns the absolute bottom of the sur-
rounding text with the bottom of the image.

The alignment options are inactive when the current image is 
placed on a layout grid. To change the relative positioning of, 
for example, a text frame and an image on a layout grid, click 
and drag the text frame or image.
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The Special Tab of the Image Inspector

Adjusting Border Width 

To activate a bounding box around the image and adjust its width, 
proceed as follows:

1
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Selecting an Alternative Message Text

To select an alternative message text for browsers that do not sup-
port graphics or have their autoload option disabled, proceed as fol-
lows:

Type in an alternative message text and press the Return key to 
confirm your entry.

To convert the image into a form button, proceed as follows:

1 Check the Is Form checkbox.

2 Type in the name you want to be displayed with the form.
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The Link Tab of the Image Inspector

Using the Image as a Link
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Selecting a Low-Resolution Image 

To select a low-resolution placeholder image, proceed as follows:

1 Select the “high-quality” image in the main document window to 
open the Image Inspector.

2 On the Basic rider, place the cursor in the Low text fielace 3s2 typ
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Importing Images via Drag & Drop 

You can also drag & drop to import graphics files from the Finder, in-
cluding GIF, JPEG, Progressive JPEG, and PICT files. You can also Com-
mand-Option-Drag images from Adobe Photoshop® and drop them 
on the document window or layout grid.

Drag & Drop Importing 
an Image File from the Finder

GoLive CyberStudio automatically converts PICT files to GIF, JPEG, or 
Progressive JPEG, placing them in the Import Images folder in the 
GoLive CyberStudio program folder or any other user-selectable 
folder.

Progressive JPEG is a new interlaced image format for the Web. De-
rived from the original JPEG (Joint Picture Experts Group) standard, 
Progressive JPEG speeds up the building of screen displays while 
minimizing file size. 

To activate automatic conversion to GIF, JPEG, or Progressive JPEG, 
proceed as follows:

1 Choose Preferences from the Edit menu and select the General icon. 

2 In the General group of preferences, click the Image tab rider to 
open the Image tab.

3
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Clickable Image Maps GoLive CyberStudio’s editor for client-side clickable image maps lets 
you create clickable maps, edit them right on top of your image, and 
link them to other resources. 

Client-Side Clickable Image Map 
and Image Inspector

Inserting a Clickable Map Since image maps are images with clickable hot spots, you will have 
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tab rider. The toolbar features map-specific buttons that let 
you shape, color, and otherwise edit your map area. 

To drattons that let 
Editing a Clickable Map You can edit the hot-spot area of the image map using the toolbar in 
the Map 
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Linking a Clickable Map 
with a Resource

You can use GoLive CyberStudio’s Point & Shoot feature to link click-
able image maps with resources.

1 Click the Point & Shoot button in the Image Inspector.

2 Drag to the desired resource file in the Project window.

3 Click the Preview tab to test the new link.

Point & Shoot Linking with a 
Resource from the Project Window

Visual feedback indicates that Point & Shoot was successful: 

• The interconnecting line blinks twice.
• The filename and directory path appear in the URL text box of 

the Image Inspector.

Because you can only Point & Shoot  at an icon in the Project  win-
dow, you should import your page and image files into a project to 
use this feature. (For more detail on projects, see Chapter 15, Man-
aging Web Sites with GoLive CyberStudio .)

Click the Point & Shoot button… 

… and drag to the desired resource file in the 
Project window.
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Horizontal Lines
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Editing Line Attributes The context-sensitive Inspector window, titled Line Inspector if a hor-
izontal line is selected, will allow you to toggle between the solid and 
three-dimensional line styles, resize the line accurately, and select 
alignment.

The Line Inspector

Toggling Line Style

To toggle the line style from olid and 

proceed as follows:

1 In the document window, click
to select the line.

2 In the Line Inspector
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2 Place the cursor in the Height text box, enter the desired height, 
and press the Return key to confirm your entry.

Aligning a Line
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Horizontal, Vertical, 
and Block Spacers

GoLive CyberStudio lets you insert horizontal, vertical, and block 
spacers into your HTML code. 

Spacers help you structure your page layout by creating a user-resiz-
able white space between text and objects. They are particularly use-
ful when you are working without the layout grid and want more 
control over your layout. The following screenshot shows how spac-
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- Block spacers resize in both directions and have three han-
dles: one at the far right, one at the lower middle and one at 
the lower right corner (for more detail on how to create block 
spacers, see Toggling Spacer Style below).

2 Click the right handle to resize the width, the lower middle han-
dle to resize the thickness, or the one at the lower right corner to 
resize the width and thickness at the same time.

Selected Block Spacer with Resize Handles

Editing Spacer Attributes The context-sensitive Inspector window, titled Spacer Inspector when 
you select a spacer, will allow you to resize, reshape, and align the 
spacer to meet your needs.

The Spacer Inspector

Toggling Spacer Style

To toggle the spacer style to horizontal, vertical, or block, proceed as 
follows:

1 In the document window, click to select the spacer.

2 In the Spacer Inspector, click the desired spacer style button.

3 In the document window, resize the spacer.

Click a handle to resize the spacer.
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Unknown Start 
and End Tags

The HyperText Markup Language is an ever-evolving language, and 
new tags will be created often. To ensure that your Web pages are al-
ways up to date and use the latest technology, you can insert place-
holders for tags that GoLive CyberStudio doesn’t recognize, type in 
the new tag names, and edit tag attributes. 

The following screenshot shows an example based on the (fictitious) 
NEWTAG element.

Unknown Tag Displayed 
by GoLive CyberStudio

Inserting an 
Unknown Tag   

To insert an unknown tag, proceed as follows:

1 Drag the Start Tag icon from the Palette and drop it on your or 
document window. 

Inserting a Start Tag and End Tag 
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To rename an existing tag or edit a tag attribute, click the Tagname 
text box or the desired attribute in the list box.

When you rename a tag, remember to click the closing tag and re-
name it accordingly in the Endtag Inspector.

To delete the currently selected attribute, click the Delete button.
The Tag Inspector

Specifying a 
New Tag        

To name the new tag, proceed as follows:

1 In the document window, click to select the unknown start tag.

2 In the Tag Inspector, enter the name of the new tag in the Tag-
name text box and press the Return key to confirm your entry.

3 Click the New button to add a new attribute. (This activates the 
text boxes below the list box.)

4 Enter an attribute name in the left text box and press the Return 
key to confirm your entry. The attribute name will appear in the 
Attribute column of the list box.

5 Enter an attribute value in the right text box and press the Return 
key to confirm your entry. The attribute value will appear in the 
Value column of the list box.

Type in the tag name here.

View the tag attributes and values in the at-
tribute list box.

Click this button to delete an attribute.

Type in the attribute name and value here.

Click this button to add a new attribute.
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JavaScript GoLive CyberStudio’s built-in support for Netscape’s JavaScript script-
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JavaScript

 in the Inspector  window.

2 Type a JavaScript dialect into the  Language  text box.

Options include:

-JavaScriptÑthe original JavaScript language developed by 

Netscape Communications Inc. and integrated in its Netscape 

Navigator 2.0 product

-JavaScript 1.1Ña new version of the JavaScript language, de-

veloped for Netscape Navigator 3.0
Setting Up a JavaScript The context-sensitive Inspector  window, now titled Body Script In-

spector , enables you to select a JavaScript dialect and open the Script 

Builder  window.

To set up a JavaScript , proceed as follows:

1 Select the JavaScript icon in the document window. This opens 

the Body Script Inspector

The Body Script Inspector

3 You can either5neference an existing script in your project or on 

your hard disk or name and build your own scripts.

-To5neference an existing script, type in a5nesource locator for 

the script file you wish to neference in the Source  text box, 

click Browse to select a script, or click the Point & Shoot  but-

ton to link to a script in the Project  window.
-To5build your own script, type in a5name in the Name  text box 

and click the EditBuilderProjectSource
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Building a JavaScript Shown below is the JavaScript Script Editor window that appears after 
clicking the Edit button in the Body Script Inspector.

The JavaScript Editor

The JavaScript Editor window is subdivided in five sections: 

• The Scripts field in the upper left corner lists all existing scripts in 
the current Web page. Clicking a script highlights it for editing.

• The Functions field in the left middle lists all functions used in 
the current script. Clicking a function highlights it for editing.

• The Events field in the middle of the window lists all objects cur-
rently defined in the document that can have event definitions. 
You can drag an event onto the editor text box to create a defini-
tion.¡

• The Event text box below the Events field lists the JavaScript code 
of the current event and lets you edit the event code.

• The Objects field holds a complete inventory of JavaScript 
objects and methods currently defined in the document.

To add and define a JavaScript, proceed as follows:

1 Drag the JavaScript icionfrom the Palette and drop it ionyour doc-
ument window or layout grid.
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The Preferences - JavaScript Dialog Box

The Tab Size text box sets the width of the indentation (in characters) 
added to lower-level tags.

The Enable dragging of  marked text checkbox toggles the internal 
drag & drop support on and off.

The Auto-indenting checkbox toggles the automatic indenting of 
lower level tags on and off.

Selecting the Soft wrap option lets the JavaScript code wrap in the 
JavaScript Editor window and in the Source view when reaching the 
margin of the window.
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Setting Up a Java Applet
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- The Bottom option aligns the baseline of surrounding text with 
the bottom of the applet.

- The Left option aligns the applet to the left of the text.

- The Right option aligns the applet to the right of the text.

- The Texttop option aligns the applet with the top of the sur-
rounding text.

- The Absmiddle option horizontally aligns the absolute center of 
surrounding text with the applet.

- The Baseline 
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Using Java Applets as 
HTML Containers
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6 Drag & drop an icon from the Palette into the applet placeholder 
or place the cursor in the applet placeholder and double-click an 
icon in the Palette. You can display any valid HTML item in the 
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Resizing Plugins 

To adjust the size of the plugin directly in the document window, 
proceed as follows:

1 In the document window, click to select the plugin placeholder 
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Naming a Plugin

To give the plugin a name that identifies it as a unique object on 
your Web page, proceed as follows:

In the Name text box, type in a name not in use by any other ob-
ject on your page and press the Return key to confirm your entry.

Editing Plugin Attributes
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Custom Interfaces for Un-
known Plugins

GoLive CyberStudio features a customizable interface for unknown 
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- Boolean lets you define an attribute with twu06teical states, 
such as 
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If the enumeration consists of boolean items, the TRUE value 
must be entered first. Example: yes,no.

12 Type in one or more descriptive labels in the Labels text box, us-
ing commas as separators. Do not use any intermediate spaces, 
unless you enclose the list in straight quotes. Example: 
black," blue ",red.

13 In the Help Text text box, type in a descriptive text.

14 When you are done defining the first attribute, Option-drag the 
attribute box to copy it, then repeat steps 6 through 13 as re-
quired.

15 Continue repeating attribute definitions until you have covered 
all necessary attributes.

16 Save the definition file, using the same filename as for the plugin 
or Java class, but append .csml instead of the standard filename 
extension.

There are three locations where you can save the definition file:

- in the same font
(1l8
/F8 1 nknownplugin )ediatfile: r Java c
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To insert a link and anchor combination via Point & Shoot, proceed 
as follows:

1
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The Anchor Inspector

3 When you are finished naming the anchor, link it this way:

- Select the text or object you wish to link from.

- Go to the Link Inspector and Point & Shoot from there to the 
anchor.

Link Warnings GoLive CyberStudio’s ability to monitor the integrity of hyperlinks in 
a project allows for alerting the author to problems resulting from 
broken links. 

Document Window with Link Warning

If the Link Warning feature is enabled, broken links appear in a user-
selectable alarm color. 

To enable the link warning feature, proceed as follows:

Go to the Edit menu and choose Show Link Warnings. 

Type in a unique anchor name here.

Broken links appear in a user-selectable alarm 
color.



150 CHAPTER 4 Links and Anchors
Alternatively, you can press Command-Shift-L or click the Link Warn-
ing button  in the Toolbar.

Link Warning Preferences
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Comments GoLive CyberStudio lets you insert hidden comments anywhere on 
your page, allowing you to add publishing information for future ref-
erence. Comments can only be viewed using a Web page editor, such 
as GoLive CyberStudio.

To insert an anchor from the Palette, proceed as follows:

1 Drag the Comment icon from the Palette and drop it in your doc-
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serted via drag & drop from the Palette and configured using a ded-icated Inspector. The line break attributes accessible via the Inspector control the way multi-line text flows around an object. 

on where you want the line(s) to break.Alternatively, you can insert a line break at the current insertion point by pressing Shift-Return.

Inspector. 4To adjust its behavior, choose an option from the Clear popup menu:-All moves the next line below the bottom of a right-aligned or left-aligned image spanning the current line.
Line BreaksFor more convenience in text editing, line breaks can now be in-

Inserting a Line BreakTo insert a line break, proceed as follows:1Drag the Line Break icon from the Palette.2Drop it at the locati

The Line Break Inspector3Select the line break symbol in the document window and click the Clear checkbox in the Line Break 
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- Left moves the next line below the bottom of a left-aligned 
image.

- Right moves the next line below the bottom of a right-aligned 
image.

The following example illustrates the effect of the line break options:

Using Line Breaks to Control Text Flow

Clear left option selected

Clear right option selected

The image was inserted at the beginning of the 
first line.
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3 In the following file selection dialog, locate the desired code base 
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2 Click the right handle to resize the width, the lower middle han-
dle to resize the height, or the one at the lower right corner to re-
size the width and height at the same time.

To view the ActiveX component icon while resizing, Control-click 
the handle of your choice and drag.

To resize the ActiveX component proportionally, Shift-click the 
handle at the lower right corner and drag.

Resizing an ActiveX Placeholder

Alternatively, you can adjust the size of the ActiveX control precisely 
and set other display options using the ActiveX Inspector: 

1 Click to place the cursor in the Width text box, enter the desired 
overall width in pixels, and press the Return key to confirm your 
entry.

- The Pixel option lets you enter the width precisely in pixels.

- The Percent option is disabled for ActiveX controls.

2 Click to place the cursor in the Height text box, enter the desired 
overall height in pixels, and press the Return key to confirm your 
entry.

- The Pixel option lets you enter the height precisely in pixels.

- The Percent option is disabled for ActiveX controls.

3 In the HSpace text box, type in the horizontal spacing in pixels 
and press the Return key to confirm your entry.

4 In the VSpace text box, type in the vertical spacing in pixels and 
press the Return key to confirm your entry.

5 To align text on the same line relative to the ActiveX control, se-
lect an option from the Align popup menu:

- The Default option aligns the ActiveX control based on the 
alignment settings of the surrounding text.

- The Top option aligns surrounding text with the top of the 
ActiveX control.

- The Middle option horizontally centers the baseline of sur-
rounding text with the ActiveX control.
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To edit the attributes of the ActiveX control, proceed as follows:

1
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3 Enter a default attribute value in the right text box and press the 
Return key to confirm your entry. The attribute value will appear 
in the Value column of the list box.

Alternatively, you can also select an existing attribute from the list 
box, click the Duplicate button and edit the attribute name and 
value text fields. 

4 To delete an attribute, select the desired entry from the list box 
and click the Delete button.

Scrolling Marquee The Marquee tag lets you place a scrolling message on your Web page 
when the IE Module is installed in the Modules folder within the 
GoLive CyberStudio program folder. The scrolling behavior can be se-
lected in a dedicated Marquee Inspector window.

Inserting a Marquee
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2 Select an option from the Behavior popup menu. This option 
controls the way the message moves accross the marquee box:

- Scroll 
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